
V1.10 updated January 2019  Page 1 

 

 

 

 
 

Recruitment and 

Selection Manual 

 

A guide for Faculties and Professional Service 

Departments 
  

 

 



V1.10 updated January 2019  Page 2 

 

 

Table of Contents 

A guide for Faculties and Professional Service Departments .................. 1 

Updates ......................................................................................... 4 

An Overview of Recruitment and Selection ......................................... 5 

Process Overview ............................................................................ 6 

Vacancies ....................................................................................... 7 

Viewing your jobs............................................................................ 8 

Recruiting Manager ......................................................................... 9 

Job Descriptions ............................................................................ 10 

Writing a Job Description ............................................................... 10 

Role Profiles ................................................................................. 11 

Person Specification ...................................................................... 12 

HERA Assessment ......................................................................... 13 

Submit the Job Description for Analysis ........................................... 13 

Job Details ................................................................................... 14 

Job Details ................................................................................... 14 

Part Time Teacher / Tutor Classifications .......................................... 22 

HR Job Board Classifications ........................................................... 22 

Advert ......................................................................................... 23 

Attach the Job Description .............................................................. 24 

Send for Approval ......................................................................... 25 

Approval flow ............................................................................... 25 

Workflow Approvals ....................................................................... 27 

Advertisement .............................................................................. 28 

Prior Consideration/Aber Refresh .................................................... 28 

Internal ....................................................................................... 29 

External ....................................................................................... 29 

Composition of Appointing Panels .................................................... 30 

Shortlisting .................................................................................. 32 

Shortlisting Prior Consideration/AberRefresh ..................................... 32 

Shortlisting applicants ................................................................... 33 

Interviews .................................................................................... 36 

Interview Questions ...................................................................... 38 

Assessment Tasks/Presentations ..................................................... 38 

Invitations .................................................................................... 39 

Selecting your preferred candidates................................................. 40 

Interview Outcome ........................................................................ 41 

 

 



V1.10 updated January 2019  Page 3 

 

Right to Work checks ....................................................................... 41 

Non-EEA Candidates ........................................................................ 41 

Offer .............................................................................................. 43 

Rejection ........................................................................................ 43 

Salary ............................................................................................ 44 

Interview documents ........................................................................ 44 

Appointment ................................................................................... 45 

Candidate Hire ................................................................................ 46 

Induction and Start .......................................................................... 47 

 

 

  

 

 



V1.10 updated January 2019  Page 4 

 

 

Updates 
This page will summaries any updates to the Recruitment and Selection 

Manual. 

Version Date Updates: 

V1.2 October 2016 Inclusion of Consumables Account 

Codes p.19 

  Addition of Job Manager and Job 

Recruiter in job details p.14 

  Change of application location from 

Folders to Jobs 

V1.3 March 2017 New job classification – Externally 

funded advertisement 

  Addition of Criminal Convictions 

  Clarification on JD against Job 

Advert, p. 22 

  Removal of COO from Post 

Approvals – all goes to PAG 

  Inclusion of Appointment Panel 

Compositions p. 29 

  Revised process overview 

  Recruiting Department to issue 

application link to casual candidates 

  No employee may begin work until 

HR has confirmed that they can 

  Demonstrators removed as 

recruitment type – now part of 

AberWorks 

  Separate application forms for 

advertised vacancies; Grade 1-5 

and 6+.  

  Inclusion of Shifts on Appointment 

Form 

V1.4 July 2017 Change to reference submission 

  Update Shortlisting  

V1.5 July 2017 General revisions and updated 

screenshots 

  Replacement of Two Ticks with 

Disability Confident 

V1.6 August 2017 Inclusion of Part Time 

Teachers/Tutors and new job 

classifications for these requests 

  Revised panel composition for Pro 

Vice-Chancellor and Institute 

Director 

V1.7 December 2017 Addition of minimum salary 

thresholds for Tier 2 Visa 

Sponsorship  

V1.8 May 2018 Pg.10 – All JDs to be translated in 

full 

V1.9 November 2018 General updates – Faculties 

V1.10 January 2019 Updated Panel compositions 
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An Overview of Recruitment and Selection 
 

Aberystwyth University recognises that its most important resource is its 

staff and that to achieve its strategic and operational goals it must attract 

and retain people of the highest calibre. The University has a broad and 

distinctive range of staffing needs. 

 

The following information aims to ensure an effective, efficient and 

consistent approach to recruitment and selection to meet those needs, 

complying with current employment and equality legislation, and providing 

clear guidance to Departments/Faculties. The policy and procedure applies 

to the recruitment of all staff, irrespective of the nature of employment. 

 

Appointing a member of staff is a significant decision. A full time Grade 1 

member of staff could commit the University to around £897,000 

expenditure over a working lifetime. Therefore recruitment decisions must 

not be taken lightly. 

 

This guide is designed to support the recruitment process, giving you the 

information that you need to make the best informed decisions and to 

ensure legal and policy compliance. Should you have any questions, 

contact the Employee Services Team, phone 8555 or email hr@aber.ac.uk.  

 

 

  

 

 

 

Information in this yellow 

bar summarises the action 

that you need to take to 

request a vacancy.  

mailto:hr@aber.ac.uk
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Process Overview 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Vacancy to be HERA Assessed, matched to role profile, or matched to existing position 

Request your vacancy in E-Recruiter 

Approval workflow 

Welsh Language Level – Finance – Departmental authorisation – HR Business Partner 

Comments – Post Approval 

Advertised vacancy Non-advertised casual or named in 

signed funding agreement 

Advertisement 

Prior Consideration/Aber Refresh 

Internal 

External 

Interview 

Recruiting Manager makes verbal offer to candidate  

(For non-EEA candidates, do not make verbal offer before 

seeking advice from HR) 

 

Recruiting Manager completes appointment form. Confirm 

name, start date, end date, salary and work schedule 

HR receives notification of appointment and begins Hire process  

Shortlisting 

HR provides Recruiting Department 

with Hyperlink to send to candidate  

The candidate must complete 

application form and new starter 

details 

 

New Employee Existing Employee 

HR completes pre-

employment checks, Right to 

Work, DBS and References. 

Approve workflow when 

complete 

Advertised Position 

Candidate receives online 

new starter form. HR Notified 

on completion 

Advertised or Casual 

Position 

HR verifies existing pre-

employment checks, Right 

to Work and References. 

HR obtains any outstanding 

checks. 

HR completes pre-

employment checks, Right to 

Work and DBS (as required). 

Approve workflow when 

complete 

 

Casual Position 

HR Hires candidate and 

completes BIF 

Passed onto Contracts team 

HR Hires candidate and 

completes BIF 

Passed onto Contracts team 

HR Hires candidate. 

Passed onto Contracts 

team 

HR informs the recruiting department that appointment is completed.  Contract will be issued as 

soon as possible 

Recruiting Department submits 

appointment form to HR 
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Vacancies 
 

Vacancies can arise to cover a new or temporary function, or to replace a 

member of staff who has left. 

 

When replacing or creating a post, you should consider the following: 

 Is this position needed, could the work be absorbed by other staff in 

the department? 

 Does this need to be full time? Could a term-time or annualised hours 

contract be suitable? 

 What minimum hours can be offered? Zero-hours and relief contracts 

should only be used in extreme circumstances. Contracted hours should 

be offered wherever possible. 

 How long do you need them for? Is this a fixed-term project or a 

permanent position?  

 Are there any new functions or activities in your Department that 

this position could work on? 

 How will the new job fit in with the existing team? Who is the line 

manager? Will you need to make changes elsewhere? Will there be an 

impact on any flexible working arrangements? Do you need to involve any 

other departments?  

 For replacement posts – were there any reasons why the person left 

that should be considered? Were they stretched or did they have 

responsibilities that should have been elsewhere? Were there any 

functions that they didn’t cover? 

 Could the needs of the vacancy be filled with a temporary 

Secondment, Acting Up or Responsibility Allowance? Allowing other team 

members to progress, even temporarily, can boost morale, create 

opportunities and develop skills of your current staff. Consider the back-

fill implications. 

  

 

[Type the sidebar content. 

A sidebar is a standalone 

supplement to the main 

document. It is often 

aligned on the left or right 

of the page, or located at 

the top or bottom. Use the 

Drawing Tools tab to 

change the formatting of 

the sidebar text box. 

Type the sidebar content. 

A sidebar is a standalone 

supplement to the main 

document. It is often 

aligned on the left or right 

of the page, or located at 

the top or bottom. Use the 

Drawing Tools tab to 

change the formatting of 

the sidebar text box.] 
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Viewing your jobs 
You can view your jobs at any time through E-Recruiter. 

 

Log onto the E-Recruiter System at: https://aber-ats-sso.hireserve.com/ 

 

On the left-hand menu, select Jobs > Job Summary. 

 

This will show you all of the jobs that you are authorised to see. It will 

summarise the job title, reference, advertising dates, applications and 

appointments.  

 

You can access the details of any job by selecting the icon on any job 

line. 

 

Using the “Status” drop down on the top menu bar, you can select: 

 Draft; to see all jobs that have been created but not yet submitted; 

 Submitted; to see all jobs that have been submitted for approval 

but are not yet been approved; 

 Approved; to see all live jobs that have been opened to applications 

but not yet been appointed; 

 Fulfilled; to see all jobs that have been appointed; 

 Withdrawn; to see all jobs that have been withdrawn. 
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Recruiting Manager 
Each job has a recruitment manager. This person is responsible for 

overseeing the recruitment, ensuring compliance with procedures, chairing 

the interview panel and making recruitment decisions.  

 

Where the Recruiting Manager is a Head of Department, they may delegate 

the responsibility of Recruiting Manager to a suitable nominee where 

specified. This may be their deputy or a section leader. 

 

Position Recruiting Manager 

Vice-Chancellor 
 Chair of Council 

Deputy Vice-Chancellor 

Pro Vice-Chancellor 

Head of Professional Service  

(Executive) 

Head of Academic 

Department 

 Vice-Chancellor 

Professor 

Reader  

Senior Lecturer  

 Pro Vice-Chancellor 

Lecturer 
 Head of Academic Department 

PDRA / Research Assistant 

Associate Lecturer 

Part-time Teacher 

 Head of Department or depute 

Head of Professional Service 

(Non-Executive) 

Grade 9/10 

 Vice-Chancellor (by request)  

 Pro Vice-Chancellor or Head of 

Professional Service 

(Executive) 

Grade 8 
 Head of Professional Service 

Grade 5/6/7 
 Head of Department (By 

request) 

 Line Manager 

Grade 3/4 
 Line Manager 

Grade 1/2/Non-HERA 
 Line Manager or nominee 

Prior Consideration 

Aber Refresh 
 Line Manager 

 

  

 

 

 

 

 

 

 

 

 

Make sure you know who 

the Recruiting Manager is 

for your job. 
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Job Descriptions 
All vacancies need a Job Description. 

 

The Job Description serves many purposes. Most importantly, it tells an 

employee what it is they are responsible for and what they should be 

doing. It must be complete and accurate.  

 

The job description informs the Higher Education Role Analysis (HERA) of 

the role. The HERA assessment determines the appropriate salary scale. 

This ensures equal pay for equal work across the University. 

 

For roles that are being advertised, the Job Description informs potential 

applicants what the position involves and should be accurate and reflective 

of the role. It is also the only insight that the cognate on an interview panel 

will have on the position. 

 

Many roles already have a Job Description in place. HR should have a copy 

of current Job Descriptions for the direct replacement of an existing 

position. It is prudent to review these older Job Descriptions to ensure that 

they are still representative of a job that can naturally change over time. 

Keep in mind if there are other people working in the same position, any 

changes may impact on their salary grade.   

 

If a Job Description does not exist, you will need to write one. 

Writing a Job Description 
When writing a Job Description, keep it brief and accurate. Make sure any 

special conditions are clear from the outset (fixed term, maternity cover, 

part time etc.). Always include a name and contact details of someone that 

applicants can speak to informally about the position. 

 

The Job Description should be an outline of their responsibilities. It does 

not need to be a long list of the tasks they will be expected to perform. 

Quantity of tasks does not impact the grade. When writing a Job 

Description, you should focus on who and what the role-holder would be 

responsible for, and the scope of those responsibilities. Take particular 

care when using the words “support”, “lead” and “manage” to accurately 

reflect their level of responsibility. The role holder cannot manage 

something if their line manager is responsible for it. 

 

Use the Job Description template available from 

https://www.aber.ac.uk/en/hr/employment-information/recruitment/. 

Make sure that you include the four standard duties that apply to all 

positions.  

 

 

If you are matching the job to a role profile, you will still need to supply a 

brief Job Description (apart from Student Experience Assistant, Academic 

 

 

 

 

You must match your job 

to an existing Job 

Description, or create a 

new one 

 

 

Even if your vacancy has 

been mapped to a Role 

Profile, it will still require a 

short Job Description to 

ensure that the Grade is 

appropriate for the Role. 

You may choose to use the 

Role Profile to inform your 

Job Description. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Use the Job Description 

Template to write your Job 

Description, including the 

essential components.  

https://www.aber.ac.uk/en/hr/employment-information/recruitment/
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Operations or Portfolio Manager which have a standard Job Descriptions 

across Academic Faculties). 

 

All Job Descriptions must be translated in full, including the advert, further 

particulars and person specification, irrespective of the Welsh Language 

requirements of the role.  

Role Profiles 
Under the Framework Agreement, a number of standard Role Profiles were 

developed to ensure consistent expectation of work across the various 

Grades across the University. All Academic Faculties have standard Role 

Profiles that should be used under normal circumstances: 

Job Title 
Associated Grade 

Academic, Teaching Only: 

Teacher1 

Associate Lecturer2 

Lecturer 

Senior Lecturer 

Chair/Reader/Professor3 

 
6 

6 

7-8 

9 

 

Academic, Teaching and Research: 

Lecturer* 

Senior Lecturer 

Chair/Reader/Professor* 

 
7-8 

9 

 

Academic, Research Only: 

Post-Graduate Research Assistant 

Post-Doctoral Research Assistant 

Post-Doctoral Research Associate 

Research Fellow 

Chair/Reader/Professor* 

 

These roles do not 

carry a particular 

grade, but are 

indicative of the level 

of responsibility 

Part Time Tutors/Demonstrators 

Undergraduate Demonstrator 

Postgraduate Demonstrator 

Senior Demonstrator 

Tutor 

 
2 

3 

4 

5 

If your job is matched to a Role Profile, it does not have to be HERA 

Assessed. 

 

The Role Profiles can be found at: 

https://www.aber.ac.uk/en/hr/employment-information/agreement/.  

  

                                           
1 Teachers and Associate Lecturers are on the same grade. Teacher would 
normally be used where they’re fewer than 7.3 hours per week. Associate 
Lecturer would normally be used for those with more substantial employment 
2 Lecturers progress naturally up grades upon satisfactory completion of 
probation and PGCTHE/HEA  Recognition. 
3 Chair/Reader/Professor – always seek advice from HR before requesting. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Even if your job is not in 

an Faculty, you may 

choose to use these Role 

Profiles. 

 

https://www.aber.ac.uk/en/hr/employment-information/agreement/
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Person Specification 
 

The person specification is essential for all advertised positions. It is not 

required for casual appointments. This outlines the essential and desirable 

criteria that must be used for shortlisting applications. 

 

Selection Criteria must be: 

 Specific. This ensures that the person specification properly reflects 

job requirements. Example: “Good Communication Skills”, “Good 

Standard of Education” or “Good Degree” is vague and subjective. 

“Experience of communicating effectively with customers”, “GCSE grade C 

in English and Maths” or “Upper second class or first class undergraduate 

degree” is much more suitable. 

 Justifiable. The criteria must be justified by the nature of the job. 

Non-justifiable criteria could be discriminatory. Example: it is not justified 

to require a Finance Administrator to have a degree-level qualification – 

the role could be performed by a candidate qualified by experience. 

 Measurable. Consider how you will assess this. They must be able 

to demonstrate the criteria that you request. Example: “Highly organised” 

is nearly impossible to provide evidence for and to compare candidates. 

“Ability to organise a large event” is much more useful as it demonstrates 

ability and should create a measurable response. 

 Non-Discriminatory. Criteria must be fair, objective and directly 

relevant. Discriminatory language or statements must not be used: 

o “A recent graduate” is discriminatory against older candidates. 

o British qualifications at the exclusion of overseas qualifications could 

be discriminatory on the grounds of National Origin. Always use “or 

equivalent”.  

o “Native English Speaker” could be discriminatory on the basis of race 

or nationality 

There are a small number of exceptions where there is a genuine 

occupational requirement. For example, age in relation to Alcohol 

sales/licensing, or employing only women in a female hostel. Graduate 

Schemes can ask for a “Recent Graduate” as this is justifiable based on 

the nature of the employment. 

The essential Criteria should be the minimum requirements for a position. 

For example, a typical entry-level administrator would require GCSE 

English and Maths (and Welsh where appropriate) or equivalent, a lecturer 

would often require a postgraduate qualification in their field. It would be 

inappropriate to have essential criteria beyond what is required. This limits 

the potential pool of applicants. 

 

The desirable criteria allow you to rank the best and most exceptional 

applicants for a position. This is where you can include desirable 

qualifications, specialisms and skills. Experience of working in Higher 

Education would be desirable for many positions. 

 

A total of 8-10 essential criteria would normally be more than enough to 

identify suitable candidates, though more may be needed for specialist 

roles. You should not have any more than 15 criteria as a maximum. Note 

that if you have 15 criteria, you will have to shortlist against all of them. 

 

Keep in mind that you want a large pool of potential applicants so that you 

can choose the best. If applicants do not meet the essential criteria, they 

 

 



V1.10 updated January 2019  Page 13 

 

are deemed as not capable of doing the job and would not normally be 

invited to interview. 

 

HERA Assessment 
Most posts must be appointed on the Aberystwyth University Single Pay 

Spine on the Salary Grade assessed by the Job Description/Role Profile. 

This is to ensure that all staff across the University receive equal pay for 

equal work. There are a small number of roles that do not sit on the Higher 

Education Role Analysis (HERA) scale, including Professors, Head of 

Departments, Farm Workers, etc. 

 

Two members of the trained staff in HR will assess the Job Description. 

 

Job descriptions should not be tailored to meet the assessment criteria 

under HERA and this should be avoided.  

 

Casual vacancies do not require HERA assessment, but will be sense-

checked and should be matched to a Role Profile wherever possible. 

 

Submit the Job Description for Analysis 
When you are satisfied that your Job Description has been finalised, send 

it to hr@aber.ac.uk for analysis. They will then return it to you when the 

assessment is complete. 

 

Where the vacancy does not require assessment, do not submit this to HR. 

 

You should now submit your job for approval. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Submit your Job 

Description to HR for 

Assessment. 

 

 

 

 

 

 

 

 

 

 

 

You can send your draft 

Job Description to Human 

Resources if you would 

like some feedback before 

it is HERA Assessed. 

 

 

Job descriptions are 

allocated a grade based on 

their content. You should 

never alter a Job 

Description to meet a 

grade. 

mailto:hr@aber.ac.uk
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Job Details 
 

The following Job Approval Process is for new or replacement roles and 

casual requests.  

 

Extensions, ends, change of hours and any other contractual change for 

an existing employee should be submitted to the Employee Services Team 

at hr@aber.ac.uk.  

 

Job Details 
 

Now that the Job Description and Person Specification has been finalised, 

you can now complete the job information. 

 

Log onto the E-Recruiter System at: https://aber-ats-sso.hireserve.com/ 

 

On the left-hand menu, select Jobs, then Create Job. 

 

This form contains all of the information that HR need to create and 

advertise a job. This information will also feed into all finance and HR 

systems, therefore accuracy is paramount. 

 

If there is any essential information missing, this may result in delays 

or rejection. 

 

If this is a re-advertisement or routinely advertised role, you can access 

the job details of a previous vacancy, then select File > Copy to replicate 

previous job details.   

 

Job Manager: 

Select the Recruiting Manager – this gives them access to view their jobs 

and to shortlist. This person is responsible for overviewing the recruitment 

process and making the recruitment decisions. This person is also the chair 

of the interview panel. 

Job Recruiter: 

Select yourself as the job Recruiter – this enables you to view and monitor 

your vacancies. 

 

Job Owner: 

Select Recruiter – this will give you full access to all the details of your 

vacancy.  

 

Do not select “do not archive applicants” 

 

 

 

 

Request a vacancy 

 

 

 

 

 

 

 

 

Log on to E-Recruiter.  

 

 

 

 

 

 

 

 

 

 

Complete the job 

details 

mailto:hr@aber.ac.uk
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Job Title: 

Enter the job title from the Job Description. Be careful when you are using 

standard job titles to make sure they are accurate. 

 

Do not populate the internal or external dates 

 

 

 

Control Details: 

Department: 

Select the Department/Faculty that the job is based in. 

 

Do no populate “Department Contact” 

Do not alter “status” 

Do not populate “Exclude from lists” 

Number of openings: 

How many vacancies are there? Enter number digits only.  

Application form: 

Select “Advertised Application” for all non-casual positions. 

Select “non-advertised Casual” for all casual appointments (reduced form 

but gathers essential information). 

Do not use any other application form 

Email to acknowledge application: 

Select “E02 On-line Application – confirm candidate” for advertised 

vacancies. 

Select “E03 On-line Application – confirm casuals” for casual 

appointments. 

 

Do not populate “URL to apply via 3rd Party” 

Do not populate “Prevent candidates from re-applying” 

Vacancy Close Workflow 

Select Start Shortlisting 

 

 

Job Roles 

Recruiting Manager: 

Select the Recruiting Manager. This person is responsible for overviewing 

the recruitment process and making the recruitment decisions. This person 

is also the chair of the interview panel. 

Welsh Language Level  

Select Gwenno Piette. In her absence, select Ruth Fowler. 

Finance 

Select your Departmental Finance Manager.  

For any externally funded research positions, select Emyr Reynolds.  

 

 

[Type the sidebar content. 

A sidebar is a standalone 

supplement to the main 

document. It is often 

aligned on the left or right 

of the page, or located at 

the top or bottom. Use the 

Drawing Tools tab to 

change the formatting of 

the sidebar text box. 

Type the sidebar content. 

A sidebar is a standalone 

supplement to the main 

document. It is often 

aligned on the left or right 

of the page, or located at 

the top or bottom. Use the 

Drawing Tools tab to 

change the formatting of 

the sidebar text box.] 
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HR Manager Check 

Select your HR Business Partner for your Faculty/Department. 

HoD / IM / Authorised Signatory 

Select the Faculty Manager or Head of Professional Service Department 

who has the authority to approve vacancies.  

Post Approval (HR) 

For all jobs, select Human Resources. 

HR Co-ordinator 

Select Human Resources. HR will allocate this once it has been approved.  

HR Recruiter 

Do not populate this unless you know the name of the HR staff who will be 

handing your recruitment.  

 

Classifications 

Do Not Populate Agresso PosNo 

HERA: 

Has the job been HERA Assessed, matched to a role profile or matched to 

an existing position? Select:  

 Yes to confirm your job has been HERA assessed, matched to a role 

profile or matched to an existing position. 

 N/A if you job is a confirmed non-HERA position. 

 If you select no, your job may be rejected until this has taken place. 

Department: 

Select the department that the job is based in. Where the job is in an 

Academic Faculty, either: 

 Select the Department that the job is in. 

 Where the job spans the Faculty (e.g. Faculty-wide administrators or 

managers), select the Faculty 

Building Location: 

Select the building in which the job is located. For remote jobs such as 

fieldworkers, please select the building in which the department is based.  

Line Manager: 

Enter the full name of the line manager of the position. 

Who is the post line managing: 

Where the job has line management responsibilities, enter the names of 

all those who will be line managed by this vacancy. 

When this is a replacement post and the line management is the same as 

the current employee, you can type “replacing existing line management” 

or similar.  

When the job does not have line management responsibilities, type “N/A”. 
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Recruitment Reason: 

Select the recruitment reason. 

 New Position for any new position 

 Replacement where this position is a direct replacement. You 

should also use this when there have been changes to job title or details. 

 Casual Appointment where you are appointing a named individual 

without advertisement, shortlisting or interview. This must only be used 

for a maximum of three months fixed term and cannot normally be 

extended. 

 Externally Funded Named Researcher where an agreement for 

research funding includes a named researcher as a condition of the 

funding. They do not have to be recruited and are treated in the same way 

as Casual, even when this extends beyond three months 

o You must upload a copy of the signed funding agreement with your 

request, detailing the named researcher. A named researcher on a Full 

Economic Costing form or Funding Application is not suitable evidence – 

this is not a requirement of the funding. If you do not provide evidence, 

the job will need to be recruited. 

Replacing who?: 

When you are requesting a replacement post, enter the name or the 

employee who has left and is being replaced. If this is not a replacement 

post, enter “N/A”. 

Business case: 

Enter a short business case to justify the vacancy. This could demonstrate 

how the job meets the needs of the Strategic Plan, will generate revenue 

or fills an essential requirement. 

Note that there is a character limit on the text box. If the business case is 

extensive, you may choose to attach this separately.  

Implications and costs if not approved: 

Enter a short statement of the implications if the post is not filled. You 

could demonstrate how this will prevent meeting the strategic plan, will 

risk the loss of revenue or will lose an essential function.  

Job Category: 

Select Academic for all teaching and research positions Grade 6 or above. 

Select Managerial, Administration and Support for all other positions. This 

controls the organisation of the website. 

Job Family: 

Select the job family appropriate for the vacancy. 

 

Please note that Campus Services does not relate to the Campus and 

Commercial Services. This would be appropriate for any positions 

providing a service to the campus in any department.  
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Academic Function: 

Select the appropriate Academic Function for the vacancy. Take particular 

care with Lecturer positions – some lecturers are teaching only and others 

are teaching and research. Ensure that this is correct. 

 “Not Academic” – for all non-Academic vacancies; 

 “Academic – Teaching and Scholarship” – for all teaching-only 

positions; 

 “Academic – Research Only” for all Research-only vacancies. 

 “Academic – Teaching and Research” for Lecturing positions where 

they are teaching and researching; 

 “Academic – not Teaching or Research” is used extremely rarely, and 

is appropriate for jobs such as Pro Vice-Chancellor where it is definitively 

an academic role but does not involve teaching or research. 

Researcher status 

Select the appropriate Researcher Status for Research-Only vacancies: 

 Not a researcher – For all positions other than Research only; 

 Post-Graduate Research Assistant – Where the researcher is 

expected to hold an undergraduate degree and is supporting research; 

 Post-Doctoral Research Assistant – It is anticipated that the role 

holder will hold a Doctorate or possess equivalent experience and is 

supporting research; 

 Post-Doctoral Research Associate – It is anticipated that the role 

holder will hold a Doctorate or possess equivalent experience and take a 

major role in research, such as a Principal Investigator or Co-Author; 

 Research Fellow – Where the researcher is expected to hold a 

Doctorate and lead on research activities. 

Grade: 

For HERA vacancies, select the Grade as confirmed by the HERA 

assessment. You can select multiple grades if required (e.g. for trainee 

positions etc.). 

For Lecturers, select the corresponding Grade 7.  

For Non-HERA, Reader, Professorial, Agricultural Wages Board and 

National Minimum Wage/Living Wage, select as appropriate.  

Salary Scale: 

Select the appropriate salary scale that corresponds with the Grade. Make 

sure that you select “(pro rata)” for all jobs that are less than full time or 

for a limited duration.  

For non-HERA vacancies, leave this section blank. 

Salary: 

Where the job is exceptional and does not match a HERA Grade, enter the 

salary in the following format. Please note that this must be entered 

bilingually with the Welsh first. 

 

£10.61 yr awr / £10.61 per hour 

£13,000 y flwyddyn / £13,000 per annum 

Funding: 

Select the funding type: 

 Wholly General Institution Financed – Use this for all internally 

funded positions. 

 Partially Financed by the Institution – Use this for all partially funded 

positions. 
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 Otherwise, select the appropriate external funding body. 

Cost Code: 

Select the cost code that is funding the job. This can be different to the 

department, for example an AberForward may be based in Geography but 

funded by 153A AberForward. 

Work Order: 

Enter the Work Order.  

Internally funded work orders should be input in the format A1234-01. 

Externally funded work orders should be input as advised by Emyr 

Reynolds. 

Account Code: 

Select the account code. 

Only use 3004 Academic Related where no other Account Code is 

appropriate.  

The codes 39XX are for Short-term or Casual vacancies only.  

External Grant Title/Reference: 

Enter the title of the grant and the reference number where appropriate. 

Otherwise enter “N/A”. 

Ext funding to cover adverts + costs: 

Where the job advertising and/or relocation costs are covered by the 

external funding, select yes. Where the costs are not covered by external 

funding, select no. 

Contract Type: 

Select Fixed Term or Permanent as appropriate. 

Duration: 

Where the job is fixed term, enter the duration of the employment in the 

following format. Please note this must be bilingual with the Welsh first. 

 

Cyfnod penodol tan 31 Gorffennaf 2017 / Fixed Term to 31 July 2017 

Cyfnod penodol o 3 mlynedd / Fixed term for 3 years 

 

Where the post is open-ended, leave this blank. 

FT/PT 

Select whether the job is Full Time (36.5 hours) or Part Time. 

 

 

Weekly hours 

When the job has regular weekly hours, enter these here as number digits 

only, e.g. “18.25”. If it has annualised hours, leave this blank. 

When you are advertising multiple roles with different hours, enter “Oriau 

amrywiol / Various hours” and include details on the job advert. 

 

All jobs should have specified contracted hours wherever possible. Zero-

hour need approval by the Deputy Director of HR and should only be 

requested when absolutely essential.  
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Annualised Hours 

If you have populated weekly hours, leave this blank. Where the job has 

annualised, term-time or irregular hours, enter the number of hours and 

the duration in the following format. Please note this must be bilingual 

with the Welsh first.  

 

600 awr y flwyddyn / 600 hours per year 

120 awr dros 3 mis / 120 hours over 3 months 

Welsh Language Levels: 

Full guidance on the Welsh Language Levels can be found at 

https://www.aber.ac.uk/en/hr/policy-and-procedure/welsh-standards/ 

 

General principles are as follows: 

 Level A0 should be used in instances where it is deemed that no 

Welsh language skills are required.  Any post which is front facing and in 

regular contact with the public as defined by the Welsh Language Scheme 

should be within the range of A1 to C2.  The “public” refers to current 

students, staff, prospective students in Wales and the general public in 

Wales.  

 In instances where a fluent Welsh speaker is required it is suggested 

that level C2 should be required for academic posts and for posts at grade 

6 and above. Otherwise level C1 may be more appropriate. 

 If writing skills are not necessary it is possible to request oral skills 

only.   

 What level of Welsh will the person require for their interactions with 

the public? 

The Levels that you select have to be verified by Welsh Language Services. 

If you anticipate any difficulties, speak with Welsh Language Services 

before submitting. 

 Essential Welsh Oral – Enter the required verbal Welsh level for the 

vacancy 

 Essential Welsh Written – Enter the required written Welsh level for 

the vacancy 

 Desirable Welsh Oral – Enter the desirable verbal Welsh Level. 

Usually this would be one level higher than essential but may be different 

depending on the nature of the vacancy. 

 Desirable Welsh Written – Enter the desirable written Welsh Level. 

Usually this would be one level higher than essential but may be different 

depending on the nature of the vacancy. 

Posts requiring Welsh language skills at levels A1 to B1 should include a 

clause to the effect that those willing to learn to this level may also apply. 

Teaching through the medium of Welsh 

For Welsh Language teaching positions, select yes. For all other positions, 

select No. 

Medical Fitness Assessment Required: 

Select yes when a Medical Fitness Assessment is required. Leave blank 

when this is not required.  

 

This should only be used where the job is physically demanding and we 

need to assess the applicant’s physical ability as required to do the job 

(i.e. regular lifting of heavy items or working in confined or dangerous 

spaces). Where this is not an essential requirement, leave this blank. 

 

 

https://www.aber.ac.uk/en/hr/policy-and-procedure/welsh-standards/
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DBS: 

Select Yes when a Disclosure and Barring Service Check is required for this 

position. Select No if it is not.  

 

Full guidance on safeguarding and DBS requirements can be found at 

https://www.aber.ac.uk/en/hr/policy-and-procedure/safeguarding/. 

 

This should only be used where a job is specifically working with children 

or vulnerable adults. 

 

Those commonly requiring a 

DBS: 

Those who don’t require a DBS 

 Those who are teaching or 

supervising children under 

the age of 18. 

 Those providing one-to-one 

guidance to vulnerable 

adults. 

 Those conducting research 

relating to children or 

vulnerable adults, or 

researching in a school or 

hospital 

 Those who are teaching on a 

course that is not aimed at 

vulnerable adults, but may 

have them attending.  

 Administrators who are 

assisting a course for children 

under 18 but not working 

directly with them 

 

Should you have any doubt when a DBS check is required, please consult 

with the Employee Services Team, phone 8555. 

DBS Rationale 

Where a DBS check is required, enter a brief explanation why this is the 

case, e.g. Teaching a class of children 

 

Where a DBS is not required, please enter “N/A” 

 

Do not populate Interview date. 

 

Preferred Start Date: 

Enter a preferred start date if you have one. Most commonly, this will be 

for fixed term research contracts or teaching dates.  

 

Where there is no preferred start date, leave this blank. 

 

Do not enter “As soon as possible” or similar. This does not look appealing 

to applicants. 

 

SOC Code (HR Field) 

Do not populate 

 

 

 

 

 

 

https://www.aber.ac.uk/en/hr/policy-and-procedure/safeguarding/
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Part Time Teacher / Tutor Classifications 

These fields are mandatory for any appointments for Part Time Teachers 

and Tutors matched to the Grade 6 and 5 Role Profiles, supplementing 

teaching on Faculty Degree Schemes. Failure to complete these fields may 

result in your request being delayed or rejected. 

 

These hours must be an accurate reflection of what the appointees are 

expected to work. Unexpected additional hours can be claimed by 

timesheet as per standard process. Hours assigned to this category of staff 

must be a true reflection of expected workload.  

 

Modules Taught 

Please include brief details of the modules that the appointee will be 

supporting teaching. Module codes are fine. 

Teaching dates 

Please specify the start and end dates of the teaching period.  

Teaching hours 

Specify the number of hours that the appointee will be expected to be 

teaching (e.g. 10x1 hour seminar =10 hours), in line with the Work 

Allocation Management Model (WAMM). 

Marking hours 

Specify the number of hours that the appointee will be expected to be 

marking in line with the WAMM. 

Preparation hours 

Specify the number of hours that the appointee will be expected to be 

preparing in line with the WAMM. 

Meeting hours 

Specify the number of hours that the appointee will be expected to be 

attending meetings.  

 

Total hours 

Specify the total hours of the teaching, marking, preparation and 

meetings. 

Total hours plus 17.6% Annual Leave 

Add an additional 17.6% to the total hours to give the resulting hours to 

allow for Annual leave entitlement. This constitutes the total hours that 

the appointee will be contracted to.  

 

 

HR Job Board Classifications 

Do not populate this section. This is used by HR for advertising purposes. 

 

 

 

 

 

 

 

 

 

 

 

 

Insert Part Time Teacher / 

Tutor Classifications as 

required 
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Advert 

Job Advert 

Do not enter anything into the Job Advert section. 

 

Job Description 

Though titled Job Description, use this section for the job advert. The Job 

Description will be attached separately.  

 

This is not required for Casual Appointments and can be left blank in this 

case. You must still attach a Job Description for all vacancy requests (see 

section below). 

 

Write a concise advert for the job. This should briefly outline the 

responsibilities of the post and make the job look inviting for applicants. 

You can include very brief information on the Department/Faculty or 

details on the project, but you might include a link to your department 

website instead. Every job is different, but you can look at other vacancies 

if you need some inspiration. 

 

Always include a name and contact details of someone they could speak 

to informally about the position, usually the Recruiting Manager. 

 

If you have the Welsh translation, please include this in the same box. 

Otherwise HR will translate this before advertising. 

 

Save 

Save your information, File > Save 
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Attach the Job Description 
You must now attach the Job Description and Person Specification to the 

job. This will be for internal use only and won’t be seen by the public. Make 

sure that you upload this as a Word (.doc) document. 

 

 Go to Options > Documents 

 Click Add a Document. 

 In Description, enter words to the effect of “Job Description for HR”. 

 Select Type as Vacancy Information Pack. 

 Do not populate Show to Candidate. 

 Do not populate Send to Agency. 

 Select the file to upload. If the Job was HERA Assessed, you must 

upload the final Job Description as was assessed. 

 

You can upload any other documents here if you choose to do so. You must 

upload a copy of the signed Funding Agreement for named researchers. 

 

Select File > Save. 

 

Return to your job details page by selecting Back in your web browser, or 

by selecting History > Jobs > Job Title. 

  

 

Attach the Job 

Description 
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Send for Approval 
When you are satisfied that all the details are complete, you must now 

submit the vacancy for approval. 

 

Select Options > Workflows > Vacancy Request. 

 

A pop up box will appear asking if you are sure you want to do this. If you 

are content, select yes. 

 

The job has been sent for approval. You do not need to take any action 

unless the job is rejected and returned to you. 

 

If your job is rejected at any stage, it will return to the job creator in the 

form of an email link. This will include the reasons for the rejection. Should 

you wish to resubmit after you have made amendments, the job must go 

through the full approval process again. 

 

Approval flow 

The approval workflow runs as follows: 

 

1) The job is sent to Welsh Language Services to confirm the Essential 

and Desirable Welsh Language Levels. They will need to approve the job 

before it will progress. 

 

2) The job is sent to your finance manager to review. They have three 

options: Approve; no funds but approved on business case; or reject. They 

will need to approve the job before it will progress. 

 

3) The job is sent to your Head of Department, Faculty Manager or other 

approved signatory to review. They will need to approve the job before it 

will progress. 

 

4) The job is sent to the HR Manager/Business Partner to comment and 

approve. This is not a formal approval stage, but allows your HR 

Manager/Business Partner to comment on the vacancy and ensure that 

the request is appropriate for your needs. 

 

5) The job is sent to HR for approval.  

The vacancy will be checked for accuracy and compliance. 

When the position is externally funded, it will automatically be approved.  

When internally funded, the job will be considered by the Post Approval 

Group. They will approve or reject the job based on the information and 

business case you have provided.  

 

6) If rejected, the job will return to the job owner. If approved, the job 

will be distributed in HR.  

a. For Casual Appointments, you will now need to make an offer to the 

candidate to be appointed – Go to Appointment section. 
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b. For vacancies to advertise, HR will collate the advert and prepare to 

advertise. This will be advertised as soon as it has been verified, approved 

and translated. You can view the status of your jobs at any time by 

accessing Jobs > Jobs Summary > Change Status to Submitted > 

Select the job details > Options > Workflow > Workflow Status. 
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Workflow Approvals 
Where you are responsible for making approvals in the workflow, you 

should follow these instructions. 

 

You will receive an email asking you to check details of a job. It will include 

a link that will take you directly to the approvals page. 

 

Click on the link. 

 

This page will provide a summary or the workflow to be completed. Job 

details and any attached documents are available on the links on the right.  

 

Review the details that are relevant to your approval, then approve or 

reject the job. 

 

 
Please make any comments that you wish to make in the comments box. 

Where you are approving with conditions, please make these explicit in 

your comments. Where you are rejecting, ensure that you include details 

why so that the job owner can resubmit with changes. 

 

Please be aware that these comments will be visible to the job owner and 

others in the workflow 

 

Select Approve or Reject. 

 

If the job owner is also an authorised signatory, you will receive multiple 

approval requests for one job. They must all be approved to allow the job 

to progress.  
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Advertisement 
There are three phases of Job Advertisement at Aberystwyth University; 

1) Prior Consideration/Aber Refresh, 2) Internal and 3) External. These 

stages have been agreed by the University and Trade Unions. 

 

Prior Consideration/Aber Refresh 
Prior Consideration and Aber Refresh are advertised simultaneously for 7 

days. 

 

Prior Consideration 

Under the Redeployment Policy, staff who are facing redeployment or 

redundancy are on Prior Consideration for all jobs. Prior Consideration 

maximises job security, minimises the requirement for compulsory 

redundancy and protects the interests of our employees whilst retaining 

skills within the University.  

 

In exceptional circumstances, Prior Consideration may be bypassed if the 

Recruiting Manager can demonstrate that the job has essential criteria that 

cannot be met by those on the redeployment register. An urgent need is 

not normally sufficient reason to bypass Prior Consideration. The 

Recruiting Manager must contact the Employee Services Team get 

approval from the Deputy Director of HR if they wish to bypass Prior 

Consideration. 

 

Refer to the Shortlisting Section on how to shortlist applicants under Prior 

Consideration. 

 

Should you be unable to appoint at Prior Consideration, or where there are 

no applicants, applications for AberRefresh are then considered. 

 

AberRefresh 

This is a scheme that allows members of staff to transfer more easily to 

new positions across the University. 

 

In exceptional circumstances, AberRefresh may be bypassed if the 

Recruiting Manager can demonstrate that the job has essential criteria that 

cannot be met by those on the redeployment register. An urgent need is 

not normally sufficient reason to bypass AberRefresh. The Recruiting 

Manager must contact the Employee Services Team get approval from the 

Deputy Director of HR if they wish to bypass AberRefresh. 

 

Should you be unable to appoint AberRefresh applicants, or when there 

are no applicants, the advert will be advertised Internally. 

 

 

 

 

 

 

 

 

 

 

 

 

Your job will be advertised 

for 7 days on Prior 

Consideration / Aber 

Refresh. 
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Internal 
All jobs are advertised for internal applications for 7 days once Prior 

Consideration/AberRefresh has been completed.  

 

Should you be unable to appoint an internal applicant, or when there are 

no applicants, the advert will be advertised externally. 

 

External 
Most jobs will be advertised externally for 30 days. For grades 1-4 where 

many applications are expected, the vacancy will be advertised for two 

weeks in the first instance. This is usually adequate to get a pool of 

applicants. 

 

In addition to our website, all jobs are also advertised with the JobCentre 

(Universal Job Match) as standard and are publicised on the University 

Twitter and Facebook accounts. All jobs Grade 6 and above are also 

advertised with jobs.ac.uk as standard. You may choose to also advertise 

elsewhere, such as with an Academic Journal, Professional Publication or 

Welsh-Language Publication. Contact the Employee Services Team if you 

would like to advertise in other places as we can advise you on this.  

 

E-mail and distribution lists are often effective advertisement for specialist 

jobs and are usually free. 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

Your job will be advertised 

for 7 days on Internal. 

 

 

 

 

 

 

 

 

External adverts must 

include an interview 

date – contact HR with 

the date and confirmed 

panel composition. 

 

If you would like your 

job advert to be 

advertised outside of 

the usual places, advise 

HR at the earliest 

opportunity 
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Composition of Appointing Panels 
The compositions of the recruitment panels are specified below. However, 

in exceptional circumstances, where this is not possible to adhere to these 

panel compositions approval should be sought from the Director of Human 

Resources or Deputy to vary the panel membership. 

 

It may be necessary in exceptional circumstances for the Vice-Chancellor 

to nominate a Pro Vice-Chancellor to take their place on the recruitment 

panel. 

 

A gender-balance should be maintained on recruitment panels. Where in 

exceptional circumstances this is not possible the agreement of the 

Director of Human Resources or Deputy should be obtained. 

 

Where candidates elect to be interviewed through the medium of welsh, 

the panel composition will ideally reflect this requirement.  Where this is 

not possible, simultaneous translation facilities will be made available.  

 

Executive level posts 

 

Vice Chancellor (in accordance with Ordinance) 

 Chair of Council (Chair) 

 Deputy Chair of Council 

 3 independent members appointed by and from the Council 

 1 member appointed by and from Senate (with provision for an 

alternate) 

 Vice-Chancellor or Principal of another university institution 

(determined by the Chair of Council) 

 University Secretary or Director of Human Resources 

 

Deputy Vice-Chancellor and Pro Vice-Chancellor (in accordance 

with Ordinance) 

 Vice-Chancellor (Chair) 

 2 independent members appointed by and from the Council 

 1 member of Senate (determined by the Vice-Chancellor) 

 [In cases of externally advertised positions] A representative of 

appropriate standing from another Higher Education Institute 

 University Secretary or Director of Human Resources 

 

Head of Professional Service (Executive members and University 

Secretary) 

 Vice-Chancellor (Chair) 

 Pro Vice-Chancellor 

 1 independent member appointed by and from the Council 

 If the post requires specialist technical skills, Chair may nominate an 

external representative 

 Director of Human Resources or depute 
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Academic Posts 

 

Head of Academic Department 

 Vice-Chancellor (Chair) 

 Pro Vice-Chancellor  

 External representative with relevant expertise (only where required 

for specialist posts e.g. for Head of IBERS this would require BBSRC 

representation) 

 Director of Human Resources or depute 

 

Professor 

 Pro Vice-Chancellor (Chair) 

 Head of Academic Department 

 External representative with relevant expertise (only where required 

for specialist posts) 

 Director of Human Resources or depute 

 

Reader 

 Pro Vice-Chancellor (Chair) 

 Head of Academic Department 

 Human Resources Business Partner 

 

Senior Lecturer 

 Pro Vice-Chancellor (Chair) 

 Head of Academic Department 

 Human Resources Business Partner 

 

Lecturer 

 Head of Academic Department (Chair) 

 Professor or Reader within the Academic Department 

 Member of Academic staff from another Academic Department 

 

PDRA/Research Assistant/Associate Lecturer /Part Time Teachers 

 Head of Department or depute (Chair) 

 Member of Academic staff from the Department (normally the line 

manager) 

 Member of staff from another Academic Department or in the case 

of collaborative projects, a member of staff from the relevant partner 

department or institution 

 

 

 

 

Professional Service Departments 

 

Head of a Professional Service or Grade 9/10 Posts (not Executive 

level) 

 Vice-Chancellor (by request)  

 Pro Vice-Chancellor or Executive level Head of Professional Service 

(Chair) 

 Head of Professional Service 

 If the post requires specialist technical skills, Chair may nominate an 

external representative 

 Director of Human Resources or depute 
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HERA Grade 8 

 Head of Professional Service* 

 Line manager or nominee 

 Member of staff from another Department 

 HR representative where requested by the Chair  

*N.B. Chair will be the relevant line manager 

 

Hera Grades 5, 6, 7 

 Head of Department (by request) Line manager (Chair) 

 Member of staff from Department unless the Head of Department is 

on the panel 

 Member of staff from another Department 

 

Hera Grades 3, 4 

 Line manager (Chair) 

 Member of staff from Department 

 Member of staff from another Department 

 

Hera Grades 1, 2 and other non-Hera posts* 

 Line Manager or nominee 

 Member of staff from Department 

 

Prior Consideration and Aber Refresh Panels (where there is 1 

candidate)  

 Line manager (Chair) 

 HR representative 

 

Where there is more than 1 candidate, the normal Composition of 

Appointing Panels must be followed. 

 

Shortlisting 
 

When a job has closed, you may now begin shortlisting. HR will send the 

application forms to the Recruiting Manager for shortlisting. 

 

The Recruiting Manager must complete the shortlisting. They should 

include members of the interview panel when doing this.  

 

Shortlisting Prior Consideration/AberRefresh 
An applicant would normally be scored 0-4 on Essential Criteria where 2 is 

a satisfactory score. Under prior consideration, an applicant is deemed to 

have a satisfactory score for a criterion where they could meet this 

requirement with training in a reasonable timeframe.  

 

For example, when it is essential that they have experience working in a 

certain area, this is something that they could reasonable gain while 

working in the job, therefore would get a satisfactory score. If, however, 

it is essential that they have a degree in a certain subject and they do not, 

this is not something that they could gain within a reasonable timeframe. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Complete shortlisting 
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Please note that shortlisting under Prior Consideration will be scrutinised 

by HR and may seek further clarification when someone has not been 

shortlisted. 

 

Shortlisting under Prior Consideration must be fully considered and 

concluded before applications under Aber Refresh are sent to you. 

 

Shortlisting applicants 
Use the Shortlisting Matrix to score the application forms. The 

shortlisting documents are available at 

https://www.aber.ac.uk/en/hr/employment-information/recruitment/ 

 

The Recruiting Manager, and anyone assisting the shortlisting, must 

declare if they have any specific interest in any of the applicants i.e. 

Colleague, family member, friend, referee etc. This will not impact the 

shortlisting but an alternative interview panel composition may be 

appropriate. Discuss any conflicts of interest with the Recruiting Manager 

who can escalate with HR if they need advice. 

 

Acquaintances and work colleagues from different teams do not pose a 

conflict worth altering panel composition, but declare them if there is any 

doubt. 

 

Fill the “Key to Shortlisting Criteria” with the Essential Criteria from the 

Person Specification. 

 

List the applications by reference number and consider each applicant 

against the essential criteria.  

 

Where there are more than 30 applicants, you may choose to do a long-

list where you score against one or two essential criteria only. This can be 

useful to reject unsatisfactory applications without fully shortlisting. 

Complete the shortlisting in full for all remaining applications. 

 

Against each criterion, an applicant should be scored 0-4: 

0. The Candidate has provided no evidence 

1. The Candidate has provided limited evidence 

2. The Candidate has provided satisfactory evidence 

3. The Candidate has provided good evidence 

4. The Candidate has provided excellent evidence 

When the shortlisting is complete, total the scores against each candidate 

and rank them.  

 

When assessing candidates that are Welsh speaking against non-Welsh 

speakers who are willing to learn, the following scoring should be used: 

0. Has not provided any evidence; 

1. Has not provided sufficient evidence; 

2. Has provided evidence of willingness to meet the Welsh language 

level; 

3. Meets the Welsh language level; 

4. Has provided evidence of having used the Welsh language 

extensively e.g. in the workplace. 

 

 

 

 

 

 

 

 

 

 

 

Complete the 

Shortlisting Matrix 

 

 

 

 

 

 

 

 

 

https://www.aber.ac.uk/en/hr/employment-information/recruitment/
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Where a candidate has scored 0 or 1 for any essential criteria, regardless 

of how well they have scored elsewhere, they are deemed to be unable to 

meet the requirements of the job, and therefore will not be invited to 

interview. 

 

When you have lots of high-scoring applications, you can shortlist against 

the desirable criteria to find the best candidates. 

 

The top 4 candidates would normally be invited to interview. Should you 

have multiple vacancies, you should increase the number of interviewed 

candidates, noting that you still have all the top scorers. Therefore for 2 

vacancies we might expect 6-8 candidates, for 3 vacancies we may expect 

8-12 etc. 

 

Prior Consideration applications at Internal or External 

The University will occasionally receive applications under prior 

consideration during the Internal or External phases. These applications 

still get prior consideration over internal and external applicants. 

 

The applicant should declare on their application form if they are eligible 

for redeployment in their declaration. Please note that this is occasionally 

ticked where it should not be, therefore always check this against their 

current or most recent employment. If they are not or have not recently 

been Aberystwyth University Employees, they cannot be eligible under 

prior consideration. 

 

The Recruiting Manager must shortlist these applications and mark the box 

on the shortlisting matrix if they are eligible under prior consideration. 

These applicants should be fully considered before any other applications. 

 

If there is any doubt if someone is eligible under Prior Consideration, 

please speak with the Employee Services Team, phone 8555, e-mail 

hr@aber.ac.uk.  

 

Disability Confident Employer 

As an equal opportunities employer, the University is accredited as a 

Disability Confident Employer. We guarantee an interview for any applicant 

who has declared a disability under this accreditation where they have met 

the essential criteria. This can be in addition to your other candidates, or 

can replace the lowest scorer as you would like. 

 

On the applications summary page in E-Recruiter, anyone who has 

declared eligibility under Disability Confident will be clearly marked. 

 

Rehabilitation of Offenders 

The Rehabilitation of Offenders Act 1974 enables certain criminal 

convictions to be ignored after the rehabilitation period. After this time, 

applicants with criminal convictions do not need to disclose them. 

 

 

 

 

 

 

 

Rank the candidates 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Check for Prior 

Consideration 

Candidates 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Check the Disability 

Confident applications, 

inviting all that meet 

the essential criteria to 

interview 
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We ask all applicants if they have been convicted of a criminal offence in 

the UK for which they are still subject to a period of rehabilitation. They 

should disclose any such convictions on their application form.  

 

Having a criminal record does not bar someone from working for the 

university. The Recruiting Manager is responsible for considering the 

nature of the vacancy against the circumstances and background of the 

offence. Convictions should not influence your shortlisting, but should be 

discussed where a disclosure has been made at the point of interview. 

Should there be any uncertainty as to whether a conviction should 

influence a recruitment decision, please discuss this with your HR Business 

Partner before making a job offer. 

 

All disclosures of convictions must be kept in the strictest of confidence 

and not disclosed with anyone who is not directly involved with your 

particular vacancy.  

 

Where a criminal conviction comes to light after the recruitment and 

selection process, please contact your HR Business Partner for advice. 

 

 

Non-EEA Candidates to be considered 

Please be aware that, where there are Non-EEA candidates for the post, 

the shortlisting matrix will be verified by the HR department to ensure that 

all shortlisted candidates meet the minimum criteria specified to be 

interviewed. This is required as part of the compliance checks HR 

undertake to meet the strict requirements of UKVI Sponsorship.  

 

Please allow sufficient time for this additional check to be undertaken when 

arranging an interview date and in returning your shortlisting matrix to 

the HR department.  Candidates cannot be invited to interview until this 

check has been carried out.   

 

Confirm candidates to be interviewed 

Based on your scores, Prior Consideration and Disability Confident, clearly 

list the candidates to the interviewed on the final page. 

 

Submit your shortlisting 

When your shortlisting is complete, send this to hr@aber.ac.uk with the 

matrix attached.  

 

You must allow HR sufficient time to give the candidates 7 days’ notice of 

their interview. Therefore, you must complete and return the shortlisting 

to the Employee Services Team at least 10 working days ahead of the 

advertised interview date. 

 

HR will contact the unsuccessful applicants and invite the successful 

candidates to interview.   

 

 

 

 

 

 

 

 

 

 

 

 

 

Confirm the shortlisted 

candidates 

 

 

Submit your 

shortlisting to HR, 

include any required 

interview information 
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Interviews 
Now that you have your shortlisted candidates, the Recruiting Manager 

must make arrangements for the interview. 

 

Interview arrangements 

The interview arrangements for vacancies must be sent to HR with the 

shortlisting documents. 

 

The interview date and panel must be confirmed before a job will be 

advertised externally. Other details must be submitted with the 

shortlisting.  

 

The Recruiting Manager is responsible for ensuring that the Employee 

Services Team has all the information required to arrange interviews. You 

must supply the following: 

 Interview Date; 

 Interview Times; 

 Interview Duration; 

 Interview Location; 

 Where and to whom should they report to? 

 Confirmation of panel members – All members must have complete 

the Equality and Diversity E-Learning; 

 Details of any assessment tasks/presentations; 

o Topic of presentation/nature of the task; 

o Date and time if held separately to the interview; 

o Duration of the presentation/task; 

o Who will be the audience; 

o Will PowerPoint Facilities be available; 

o Assessment criteria for the task/presentation. 

UK residents will ordinarily be invited to attend an interview in person and 

are able to claim expenses in accordance with policy. Candidates travelling 

from outside the UK will normally be invited to interview by Skype. If you 

wish to invite these candidates to attend an interview in person, the 

Recruiting Manager must make a request to the Deputy Director of HR. 

This will ordinarily be allowed for the most senior appointments. 

 

All panel members, led by the Recruiting Manager, should familiarise 

themselves with the candidates’ applications and the Job Description in 

advance of the interviews. 

 

Question-and-answer interviews are most common, but we also encourage 

the use of work based exercise selection alongside this. Teaching staff are 

generally expected to make a presentation or short lecture on their subject 

area or teaching style. Administrative roles can be asked to complete an 

in-tray or admin exercise. Technical or catering staff could be asked to 

complete a task. These assessments can be more representative of the 

candidate’s general performance and abilities.  

 

 

 

 

 

 

Confirm the interview 

details. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



V1.10 updated January 2019  Page 37 

 

Interview contents 

All interviews should be opened with greetings and introduction, the offer 

of water and a brief overview of the department and the job. This prevents 

confusion while also enabling the candidate to relax into the interview. 

Explain that the panel will be making notes during the interview. 

 

All vacancies that are Welsh Language Level B1 or above must include a 

question or assessment task to assess the candidates Welsh Language 

abilities to compare against the essential criteria. 

 

All interviews should end with an opportunity for candidates to ask 

questions. You should ask the candidates to report to HR with their Right 

to Work and Certificates if they have not already done so. They should be 

informed when they can expect to hear the outcome and be escorted to 

the door/nearby public space. 

Good interview practice 

 Try to create a rapport with the candidates to make them 

comfortable; 

 Keep an eye on the time. If the candidate begins to ramble, you may 

ask them to conclude their answer to move on. You should avoid keeping 

candidates waiting; 

 Avoid making assumptions on the candidate’s skills or abilities, 

especially from their work experience or any disclosed disabilities; 

 Ensure mobile phones are switched off. Vibrating phones are just as 

distracting and disrespectful; 

 Be aware of your body language. Try to be open and welcoming. 

Avoid crossed arms and maintain eye contact when you are not writing 

notes; 

 Do not ask personal questions that are not related to the job, i.e. 

family, age, other commitments. If the candidate talks about any of these 

areas without a question, you can ask them to stop; 

 Be aware of interviewer bias: 

o Halo Effect – Same accent, appearance, school as you; 

o Horn Effect – Judgement based on accent, weight, appearance etc.; 

o ‘Like me’ Effect – the candidate is just like the boss; 

o Judgement based on cultural differences; 

o Judgement based on gender stereotypes. 

 

Guidance for Interviews of Prior Consideration Candidates 

Where there is only one Prior Consideration candidate, the interview 

should be informal. You do not require the full interview panel. The 

recruiting manager and a member of the HR team are required. 

 

Should there be multiple candidates, you should follow the formal 

interview process, but to establish the most capable candidate. 

 

The questions should be brief and based entirely on the Essential Criteria, 

designed to establish that the candidate is capable of doing the job with 

reasonable training. Therefore if they are close to meeting the essential 

criteria, they would ordinarily be appointable. You should not ask any 

questions that are not based on the Essentials, such as “Why have you 

applied for this position”. This is inappropriate for Prior Consideration 

Candidates. 

 

 

 

You should include this 

standard information in 

every interview. 
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If you do not feel that the candidate is appointable, you must get approval 

from the Director of HR before you inform the candidate of the outcome. 

You will need to demonstrate why the candidate is not capable of doing 

the job with reasonable training. When the Director of HR has confirmed, 

you can communicate the recruitment decision. 

 

Interview Questions 
The Recruiting Manager is responsible for creating and compiling the 

questions for the interview, in conjunction with the interview panel. There 

should be a maximum of 8 questions, though 6 is usually ample for most 

interviews. These should be focussed on the Essential or Desirable Criteria 

(avoid doubling up on information that you have already established from 

the application form), or can focus on the expected tasks/responsibilities 

of the job. 

 

Questions such as “Tell me about a time when…” or “What experience do 

you have doing…” are very practical and assess their actual experience 

and skills. This is more useful than asking someone “how do you prioritise” 

as the answers are usually theoretical and not based on actual experience 

or skills. 

 

Questions should be open to encourage the candidate to do most of the 

talking.  

 

Questions should be clear, direct and short. Long or wordy questions are 

very difficult for a nervous candidate to understand. Multiple-part 

questions are fine, but allow the candidate to answer each part before 

moving to the next, otherwise it can be overwhelming.  

 

All candidates must be asked the same questions. Should the candidate 

miss the point of the question or be particularly brief, panel members are 

welcome to prompt or remind the candidate. This gives nervous candidates 

a chance to do their best, but care should be taken not to provide an 

answer. Where they have required a lot of prompting, this should be 

reflected in their notes and scores. 

 

 

 

 

Assessment Tasks/Presentations 
In addition to a straight question/answer interview, there is great benefit 

in having an assessment task or presentation. For a practical job, you can 

better assess a candidate’s ability to do the job. Normally these would 

happen immediately before the interview so that there’s no delay on post-

interview discussions. 

 

In most cases, a presentation would be to the interview panel only, would 

not be offered presentation facilities and would limit their handout to 1 

sheet of A4. 

 

 

 

 

 

 

Prepare the interview 

questions 
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Academic positions would normally be expected to make a presentation, 

mini-lecture or lecture except of around 15 minutes plus questions. A 

Lecturer could be asked to do a mini-Lecture on their research or on a core 

teaching area in the Department. Alternatively they could make a 

presentation on their teaching methods or experience. A Researcher could 

do a presentation on their research areas.  

 

For Academic position, you may choose to invite an audience of 

departmental colleagues to attend the lecture/presentation, ask questions 

and be invited to share their views on the candidates. They should 

complete presentation feedback forms to be compiled and summarised by 

the Recruiting Manager or their nominee who must oversee the 

presentations.  

 

The Recruiting Manager or their nominee should arrange for feedback to 

be provided to the interview panel. The feedback should be based on 

content, quality of presentation, response to questions etc. and should be 

given a score.  

 

For non-academic jobs, the variety of jobs does not make it practical to 

have standard assessment tasks, and we encourage Recruiting Managers 

to design their own tasks appropriate for the position in conjunction with 

their HR Business Partner, for example: 

 Administrative positions may be asked to do an in-tray exercise, 

excel task or respond to some queries by email. This is also an opportune 

moment to assess their written Welsh abilities where this is a requirement. 

 Financial or data positions may be asked to analyse excel data and 

create a report. 

 Catering positions may be asked to create an example menu with 

budgets or cook an omelette. 

 Managers may be asked to do a presentation on their managerial 

style or an extended “what changes would you make” presentation. 

When preparing assessment tasks, you must ensure that they have a 

correct or desired result. They should be practical and measurable so that 

the candidates can be compared objectively. 

 

 

Invitations 
HR will issue interview invitations by email to the successful candidates at 

least 7 days prior to the interview date. This will include details of any 

presentation that they are expected to provide, or a summary of the 

assessment tasks. 

 

 

 

 

 

 

 

 

Prepare any interview 

assessments/ 

presentations 
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Selecting your preferred candidates 
Using the Interview Summary Sheets, each panel member must make 

notes on the answers that the candidates give. You should also include 

conclusions on the presentations/assessment tasks. These notes must be 

written in pen, legible and practical to score. These will be used to provide 

feedback to the candidates, and the candidate can request to see these. 

You can include a note such as “wore red jacket” as a reminder, but must 

not include anything such as “terrible fashion sense” or “bad body odour”. 

These comments are inappropriate. 

 

Each question should be given a score of 0-4: 

0. The Candidate has provided a poor or incorrect answer  

1. The Candidate has provided a limited answer 

2. The Candidate has provided a satisfactory answer 

3. The Candidate has provided a good answer 

4. The Candidate has provided an excellent answer 

 

You may choose to score assessment tasks or presentations differently if 

it has a heavier weighting, such as a lecture for a teaching position, but 

you must keep a measurable objective score.  

 

You may choose to leave all of your scoring to the end to assist consistent 

scoring across all the candidates.  

 

The panel should have a brief discussion on the scores and the candidates. 

Interviewing is difficult and it is easy to forget something that a candidate 

has said. For specialist roles, the panel cognate may need some guidance 

on any questions that they may not have the specialism to fully 

understand. Panel members are welcome to amend their scores should the 

discussion change their view. 

 

All of the scores should be totalled for each candidate for each panel 

member. Write these onto the Interview Summary Matrix and total all of 

the scores. The highest scoring candidate(s) should be appointed. 
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Interview Outcome 

Right to Work checks 
HR and other selected staff have been trained in conducting Right-to-

Work checks, where candidates are asked to provide documentation to 

confirm their Right to Work in the UK. Most commonly, they provide a 

passport, EU ID card or Residence Permit/Visa. UK citizens can also 

provide a full birth certificate with proof of national insurance number. 

 

All candidates are asked to bring their Right to Work documents to HR 

on the day on their interview. Skype candidates are asked to supply a 

copy of their Right to Work by email which must be verified in person 

before they start work. 

 

It is a legal requirement that we hold current and valid Right-to-

Work documents for all employees before they begin work. 

Further to this, it is a requirement of our Visa Sponsorship 

Licence and United Kingdom Visas and Immigration regulations. 

Non-EEA Candidates  
If the successful candidate is not from the European Economic Area 

(EEA) or Switzerland, do not make any offers until you have discussed 

with the Employee Services Team. There are additional compliance 

requirements for these candidates that must be fulfilled before an offer 

can be made. 

 

If an Faculty/Department wishes to appoint a candidate who is not a 

citizen of the European Economic Area and would need the University to 

issue a certificate of sponsorship, we need to demonstrate why the 

individual was appointed over a settled worker.  If there are multiple 

candidates who have the necessary skills and experience, then a settled 

worker must be appointed over the non-EEA candidate even if the 

migrant has more skills or experience. There are exceptions to this for 

the following PHD level positions where you can appoint a migrant if they 

are the most suitable candidate. These positions are: Chemical 

Scientists, Biological Scientists and Biochemists, Physical Scientists, 

Social and Humanities Scientists, Natural and Social Science 

Professionals not elsewhere classified, Research and Development 

Managers, and Higher Education Teaching Professionals. 

 

Each category of PhD position is accompanied by a minimum salary 

threshold, linked to the “SOC code”. The salary offered must meet these 

minimum thresholds otherwise we cannot issue a Certificate of 

Sponsorship for a Visa 

 

As of August 2017, typical salary thresholds would be £28,000 for an 

experienced Scientist, or £32,300 for a Higher Education Teaching 

Professional. Be aware that these are constantly under review and are 

regularly increased.  
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The Recruiting Manager, in conjunction with HR, must complete and sign 

off a Tier 2 Form outlining the reasons for non-appointment of EEA 

candidates. 
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Offer 
The Recruiting Manager should contact the successful candidate to inform 

them of the outcome (Unless non-EEA as above). Once this has been done, 

you will need to discuss and confirm the following: 

 Salary4 

 Hours/days of work (Work Schedule) 

 Conditions of the offer (references, Disclosure and Barring Service 

Check, right to work check) 

o Where a DBS is required, the candidate must not begin working until 

a satisfactory DBS certificate has been received (unless permitted by HR) 

o No-one may begin working until HR has verified their Right-to-Work 

in the UK. This is an essential condition of our Sponsor License and could 

have significant consequences if not adhered to. 

 Proposed start date 

 Probation period (2 years for academic staff, 12 months professional 

service staff) 

Any discussions can constitute a verbal contract that is legally binding, so 

please ensure that you cover the conditions of employment and do not 

offer anything that we may not be able to deliver, such as relocation 

packages that are not within procedure. 

 

The candidate may ask for some time to consider the offer before 

confirming if they accept the job. This is fine, but you should ask them to 

confirm within a reasonable timeframe.  

 

Rejection 
When the successful candidate has provisionally accepted the position, the 

Recruiting Manager or their nominee must contact the unsuccessful 

candidates to inform them of the outcome. The Recruiting Manager may 

delegate this to another member of the interview panel if they choose to. 

 

Receiving a rejection is a very unpleasant experience and should be done 

with sensitivity and tact. They will be expecting your call, so do not prolong 

it any more than necessary. You should offer them the opportunity for 

feedback, either now or at a later date.  

 

Receiving constructive feedback is very desirable and should be as 

practical as possible. Try to avoid comparing them to the other candidates, 

telling them something material that they can improve or work on. Try to 

sandwich the feedback between the highlights and strengths of their 

interview. When appropriate, encourage them to apply for other vacancies 

in the future. 

 
 

                                           
4 Be aware of the minimum salary thresholds for Non-EEA applicants, see 

Non-EEA section. 

 

 

Make a verbal offer to 

the successful 

candidate or Casual 

Appointment. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Recruiting 

Manager or Nominee 

must contact the 

unsuccessful 

candidates to inform 

them of the outcome 
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Salary 
Confirm the Spinal Point on which the successful candidate will be 

appointed. Ordinarily, they would be appointed on the lowest point of the 

respective grade. In certain circumstances, a successful candidate would 

be appointed higher on the scale, such as when they bring particular skills 

or strengths, or in comparison to their current salary. The Recruiting 

Manager has discretion to appoint anywhere in the advertised grade, but 

may be asked to justify their reasoning.  

 

Lecturers are ordinarily appointed to Grade 7, Spinal Point 33. They would 

normally progress to Grade 8 on completion of probation and PGCTHE or 

Fellowship of the HEA. You may appoint a lecturer to a higher Spinal Point 

if you can demonstrate that their specialism and skills are sufficient. You 

may appoint a lecturer to grade 8 if they demonstrate specialism and skills 

and have achieved PGCTHE or Fellowship of the HEA. 

 

Sometimes, the successful candidate will request to be appointed higher 

on the salary scale. This is at the discretion of the Recruiting Manager, but 

they will need to consider if they can justify it. If the Recruiting Manager 

does not feel that this can be justified, then the offer should be reiterated. 

It is then up to the candidate to either accept or reject the offer. Should 

they reject it, this should be documented (preferably as an email trail), 

and an offer subsequently made to the next highest scoring candidate 

subject to pre-employment checks.  

 

Interview documents 
You must submit all the interview documents by email to hr@aber.ac.uk. 

All these documents must be completed in full and written legibly in pen.  

 Copy of the interview questions; 

 Interview assessment sheets (one per panel member per candidate); 

 Interview Summary Matrix, confirming candidate to be appointed; 

 Interview Summary Sheet. 

HR will confirm the offer of employment when these have been received. 

 

Be aware that candidates have the right to view the recruiting paperwork 

and it may be subject to audits from UKVI and external funders. 

  

 

 

 

 

 

 

 

 

Contact the 

unsuccessful 

candidates to inform 

them of the outcome 

and provide feedback 

 

 

 

 

 

 

 

 

 

 

Confirm the salary 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Submit the interview 

documents to HR 
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Appointment 
 

To appoint to an advertised vacancy, complete an appointment form. 

 

The Recruiting Manager must complete the appointment form in full. 

Submit this form to hr@aber.ac.uk with any recruitment paperwork. 

 

You must include the following: 

 

Name of Person to be appointed: 

Enter the full name of the successful candidate. 

Email: 

Enter the email address of the candidate (required for casual 

appointments) 

Start Date 

Enter the proposed date on which the Candidate will begin working 

(subject to pre-employment checks). This must be a specific date – we will 

not accept “as soon as possible”.  

End Date (if applicable) 

For fixed term appointments, please select the end date. Please note: 

 Fixed term periods for whole weeks should end on the Sunday, even 

if their last day would be on the Friday 

 Fixed term periods for whole months should end as such: 1st March 

– 31st March, 15 April – 14 May. (15 April – 15 May would be one month 

and one day) 

Grade and Spinal Point 

Where appointments have been made on the HERA scale, confirm the 

spinal point to which they are to be appointed, otherwise, please enter the 

salary.  

 

Will this person be working Shifts? 

Select yes or no. Shift work attracts enhanced pay in accordance with the 

Framework agreement. 

 

Shifts are defined as working either: 

 An agreed shift pattern covering at least 11 out of 24 hours (i.e. will 

be working at least 11 continuous hours) 

 For grades 1 or 2 only, split-shifts are where staff are attending more 

than one shift on a day, with a gap of 2 or more hours in between shifts.   

 

Work Schedule and Total Hours 

Complete the table with the work schedule that the appointee will be 

working (exclusive of breaks). 
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You must include the days and times of work and the total hours. Where 

Candidates will be working on a shift pattern, please include the full shift 

pattern confirming the start date of the pattern.  

 

It is very important that work schedules are correct. These have a 

significant impact on annual leave balances and the ability to record leave 

and other absences. The work schedule should be confirmed with the 

candidate at the verbal offer.  

 

HR cannot action an appointment without a complete work schedule 

 

 

Candidate Hire 
 

When the appointment form has been received, accompanied with any 

relevant recruitment paperwork, HR will complete the pre-employment 

checks for the selected individual(s). HR will confirm that the Right to Work 

check is in place, submit references and complete a DBS check where 

appropriate.  

 

References will be sent to the Recruiting Manager by HR when they have 

been received. 

 

When the pre-employment checks have been completed, the candidate 

will receive an email asking them to complete a form to complete their 

employee information, including Next of Kin and Emergency contact 

details, health information and Bank and Tax details.  

 

When completed, HR will “hire” the candidate, create them in ABW and 

issue their contract.  
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Induction and Start 
It is the responsibility of the Recruiting Manager or the position’s Line 

Manager to make arrangements for the candidate’s first days at work. 

They should arrange: 

 Start date and time 

 Where they should report to 

 Work equipment should be made available: 

o Desk/phone/computer 

o Locker/drawers 

o Equipment/machinery 

 Departmental induction, tour etc. 

For new staff who have been issued with a Certificate of Sponsorship, a 

Right to Work check must be undertaken PRIOR to them starting work. 

This must not be done on their first day. 

 

HR will contact the Sponsored member of staff and their Line Manager to 

attend a meeting at 9:00 on their first day of work to discuss their 

responsibilities and the University’s obligations under UKVI Guidance. Both 

parties will be required to sign a letter to confirm that they have read and 

understood their responsibilities.  

 

HR runs an induction every second Monday (or following day where this 

falls on a bank holiday). All new staff are expected to attend this induction. 

This covers general information on the University and Policies and 

procedures and PoblAberPeople, as well as an opportunity for the 

employee to ask any questions in relation to their employment. Health, 

Safety and Environment also attend for a brief induction.  

 

For permanent staff, there is a Welcome New Colleagues Event which 

takes place every six months. This is also compulsory. This is a one-hour 

event led by a member of the Executive Committee as a welcome event 

for all staff as well as an opportunity for staff to meet new colleagues from 

across the University. Trade Unions are also often in attendance. 

 

All staff must also complete a Health, Safety and Environment Induction 

Report, available from the Health, Safety and Environment web pages. For 

short-term or casual staff, this should be completed within their first 2 

working days, or first two weeks for permanent staff.  

 

All staff must also complete the Diversity E-Learning Course, details of 

which are provided to them at the HR induction. 

 

It is up to the recruiting department to induct your new starters. There are 

a number of templates available on the University website, but these 

should be tailored towards the job and your departmental needs. They 

should be shown how to use key equipment, be shown around the 

department, introduced to colleagues and guided on emergency 

procedures. 

 

 


